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UM0949
User manual

STMT/8L-EV1
STM8L evaluation board with touch-sensing library

Introduction
The STM8L evaluation board with the touch-sensing library enables designers, who are 
familiar with the standard STM8Lxxx microcontrollers, to create higher-end look-and-feel 
user interfaces by replacing conventional electromechanical switches with touch-sensing 
controls. Designers can thus combine touch-sensing functions with traditional MCU features 
such as communication, LED control, beeper, LCD control, and so on. 

The touch-sensing firmware library is part of the application firmware. 

Maturity, robustness, flexibility, and outstanding performance make the STM8L evaluation 
board with the touch-sensing library a simple and robust solution. In addition, its low time-to- 
market period facilitates the development of numerous applications including mobile 
phones, cooking appliances and printers, to name a few. 

In development mode, designers can debug, modify, adapt, or integrate the touch-sensing 
library in the application firmware using the ST MCU toolset with the ST Visual Develop 
(STVD) IDE interface.

Evaluation firmware

Evaluation firmware is preloaded in the board's STM8L15x device for easy demonstration of 
the device peripherals in stand-alone mode. To download the latest version and for more 
information refer to the STMT/8L-EV1 demonstration software available on www.st.com.

Order code

To order the STM8L evaluation board with the touch-sensing library, use the order code 
STMT/8L-EV1.

Figure 1. STM8L evaluation board 

www.st.com
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1 Overview

1.1 Contents 
The STM8L evaluation board package contains an MB931 board.

Note: This document, the STM8 touch-sensing library, STM8 toolset, STM8L15xxx standard 
library, and all related documentation are available at www.st.com/touch-sensing-library

1.2 Features

1.2.1 Touch-sensing library

● Robust and proven charge-transfer acquisition principle

● Excellent immunity against conductive noise 

● Supports up to 16 capacitive sensing channels 

● Low BOM with only 1 I/O per channel + 1 I/O per acquisition group for sampling 
capacitors

● Up to 8-bit resolution wheel/slider using 3 channels

● Fast acquisition time (2 ms typical for touchkey, 7 ms typical for a wheel/slider)

● Advanced processing featuring:

– Autocalibration

– Debounce filtering

– Environment control system (ECS)

– Detection exclusion system (DxS)

● Free C source code library

1.2.2 STM8L evaluation board

● Uses an STM8L microcontroller (STM8L151C6) in a 48-pin LQFP package.

● Preprogrammed with evaluation firmware that manages:

– 10 touchkeys made of a simple copper surface

– 1 slider consisting of three interlaced electrodes

– 1 wheel consisting of three interlaced electrodes

● Analysis connectors: All electrodes and signals are available through three connectors 
(CN1, CN2, and CN8) for analysis and monitoring. 

● Communication connector: The board provides a connector (CN4) for interfacing with 
the UART, SPI, or I2C of the microcontroller. 

● Embedded ST-Link interface to quickly program and debug the firmware. This interface 
is accessible through the USB connector (CN7).

Figure 2 shows the main features of the STM8L evaluation board.
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Figure 2. Main features 

1.3 User interface 
The STM8L evaluation board user interface is composed of: 

● An LCD screen

● A joystick

The user interface can: 

● Display touchkeys, slider, and wheel values and states (via display submenus).

● Modify the main touch-sensing library parameters, such as, debounce filter, detection 
timeout, low power mode, detection exclusion system setting, etc. (via parameter 
setting submenus). 

● The joystick (U2) is used to navigate into the different menus that appear on the LCD 
screen:

– Click right: go to the next menu

– Click left: go to the previous menu

– Click up: go to the parent menu

– Click down: go to the sub-menu

See Figure 3: Joystick.

Reset button USB connector

10 keys

Wheel

Slider

Joystick (U2): Entry/Exit into touch-sensing menus

Communication connector
IDD measurement

Analysis connectors
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Figure 3. Joystick
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2 Analysis and development features

2.1 STM8L evaluation board options

2.1.1 Power supply

The evaluation board is powered to 3.3 V (supplied via the USB connector providing 5 V). 
Without being connected to the USB connector, the board can be supplied by an external 
power supply via the Test point TP1 (5V) and TP2 (GND).

2.1.2 Analysis connectors (CN1, CN2, and CN8) 

Application designers can use connectors CN1, CN2, and CN8 to analyze electrodes and 
driven shield signals on the evaluation board. 

Note: The user should take into account possible probe capacitance disturbance and should 
consider recalibrating the device before use. 

         

2.1.3 Communication connector (CN4)

The communication connector, CN4, provides the I2C, SPI, and UART pins of the 
microcontroller. The user can use these pins to develop his own communication protocol. 

         

Table 1. CN1, CN2, and CN8 connector pin descriptions

CN1
pin

Description 
CN2
pin

Description
CN8
pin

Description 

1 Key 0 electrode 1 Slider electrode A 1 Wheel electrode C 

2 Key 1 electrode 2 Slider electrode B 2 Wheel electrode B 

3 Key 2 electrode 3 Slider electrode C 3 Wheel electrode A 

4 Key 3 electrode 

5 Key 4 electrode 

6 Key 5 electrode 

7 Key 6 electrode 

8 Key 7 electrode 

9 Key 8 electrode 

10 Key 9 electrode 

Table 2. CN4 connector pin description

Pin number Description Pin number Description 

1 VDD_3V3 2 VSS 

3 SPI_MOSI 4 NCHG 

5 SPI_MISO 6 I2C_SDA 

7 SPI_SCK-UART_RX 8 I2C_SCL 

9 SPI_NSS-UART_TX 10 VSS 
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2.2 Dielectric
A 1.5 mm acrylic front panel, with a dielectric constant of 3, is placed on top of the 
electrodes. It is glued using a standard 3M 467MP adhesive. You may also find some 
STMT/8L-EV1 evaluation boards with a top layer silkscreen which improves the overall look 
and feel of the solution.
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3 Getting started

Once the STM8L evaluation board is connected to the USB connector, it is ready to use. 
The evaluation firmware enables the user to quickly evaluate the main features of the touch-
sensing library by using the different touch electrodes (touchkeys, wheel and slider), the 
LCD screen and the joystick button.

3.1 Main level menus
Figure 4 shows the main level menus. The channels information menus (A) are described in 
more detail in Figure 5. Menus depicted in blue (0, 1, 6, and 7) and yellow (2, 3, 4, and 5) 
are explained in Table 3: Menu explication. The blue menus display information and the 
yellow menus are used to change settings.

Figure 4. Main level menus
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3.2 Channels information menus
Figure 5 shows the channels information menus. The slider and wheel menus (B and C 
respectively) are described in more detail in Figure 6. Menus depicted in blue (7 and 8) and 
yellow (9, 10, and 11) are explained in Table 3: Menu explication.

Figure 5. Channels information menus (A)
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3.3 Slider and wheel menus
Figure 6 shows the slider (A) and wheel (B) menus. Menus depicted in blue (12, 12’, 13, 13’, 
14, and 14’) and yellow (15 and 15’) are explained in Table 3: Menu explication.

Figure 6. Slider and wheel menus

( )
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3.4 Menu explication
         

Table 3. Menu explication

Number 
of menu

Name of 
menu

Explication of menu

0 Introduction
Displays the evaluation board firmware name then automatically jumps to 
menu 7 (Summary).

1 Help
Displays a brief explanation of how to navigate into the menus. The text is 
scrolled automatically by clicking “down”, “up”, “left or right”.

2
Detect 
Timeout

The Detection Timeout feature automatically recalibrates the keys after a 
fixed duration of continuous touch detection. This prevents the keys from 
becoming “stuck-on” due to foreign objects (including water or steam) or 
other sudden influences (like moving the device from the hand to the 
pocket). After recalibration, the keys continue to operate normally even if 
they are partially or fully obstructed. Infinite timeout (detection timeout is 
OFF) is useful in applications where a prolonged detection can occur and 
where the output must reflect the detection regardless of its duration.

The default setting is OFF. Possible settings include: 1 to 20 s with 1 s 
step.

3
Debounce 
Filter

The Debounce Filter feature reduces the effects of low frequency noise 
on key states. This mechanism requires a specified number of 
measurements that qualify as detections. The measurements must occur 
consecutively otherwise a detection is not reported. Similarly, the end of a 
touch (loss of signal) also has to be confirmed over several 
measurements. This process acts as a type of debounce mechanism 
against noise.
The default setting is 2. Possible settings include: 1 to 9.

4
Low Power 
Mode

An example of low power management is provided with this evaluation 
board. When activated, the device enters halt mode for a configurable 
period of time after each complete acquisition loop. The system does not 
allow entry into low power mode simultaneous with entry into detection or 
calibration. Please note that Low Power Mode does not affect the system 
timings like environment control system (ECS) or detection timeout. 
Warning: navigation of the menus is slowed down when an important 
value (> 64 ms) is set.

The default setting is OFF. Possible settings include: 1 ms/2 ms/4 ms/
8 ms/16 ms/32 ms/64 ms/128 ms/256 ms/512 ms

5
Detection 
exclusion 
system (DxS)

The DxS feature prevents multiple keys from responding to a single 
touch. This can happen with closely spaced keys. Once a key is 
considered to have been touched, all other keys are locked in an 
untouched state. To unlock these keys, the touched key must first return 
to an untouched state.
The default setting is OFF. Possible settings include: All keys, wheel and 
slider/keys only/keys 0 to 8 only.

6 About
Displays the firmware version. The letter after the version indicates which 
compiler was used: “C” for Cosmic, “R” for Raisonance and “I” for IAR.
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7 Summary

Displays the activity of all the keys, and the slider and wheel. When a key 
is touched, an arrow is added to the right of the key number (from 0 to 9). 
The number after the “W:” and “S:” characters are respectively the wheel 
and slider position in hexadecimal format.
Note: This display appears just after the introduction display when the 
board is reset.

8

Reference, 
signal, delta, 
and state of 
selected key 
(keys 0 to 9)

Displays the reference (R), signal (S),  delta (D) and the state of the 
selected key. The joystick (left or right button) is used to change keys. The 
states of the keys are: pre calibration, calibration, idle, predetected, 
detected, postdetected, disabled, and error.

9
Key 9 
detection 
threshold

This feature allows the detection threshold of key 9 to be changed. To 
prevent bad behavior of the system, the end of detection threshold value 
is automatically decreased to allow a minimum difference of 1 between 
the two values.

The default setting is 30. The minimum value is 2 and the maximum value 
is 127. All values in between 2 and 127 can be set.

10
Key 9 end 
detection 
threshold

This feature allows the end of detection threshold of key 9 to be changed. 
To prevent bad behavior of the system, the detection threshold value is 
automatically increased to allow a minimum difference of 1 between the 
two values.

The default setting is 15. The minimum value is 1 and the maximum value 
is 126. All values in between 1 and 126 can be set.

11
Key 9 
recalibration 
threshold

This feature allows the recalibration threshold of key 9 to be changed.
The default setting is -15. The minimum value is -1 and the maximum 
value is -128. All values in between -1 and -128 can be set.

12, 12’
Slider/Wheel 
state

Displays the Slider/Wheel state (pre calibration, calibration, idle, 
predetected, detected, postdetected, disabled, and error).

13, 13’
Slider/Wheel 
reference and 
signal

Displays the Slider/Wheel reference (values after the “R” on the first line) 
and signal (values after the “S” on the second line) for the three channels.

14, 14’

Slider/Wheel 
delta, position, 
and filtered 
position

Displays the Slider/Wheel delta (after the “D” on the first line) for the three 
channels, position (after the letter “P”) and filtered position (after the 
letters “FP”) values in hexadecimal format.

15, 15’
Slider/Wheel 
resolution

This feature allows the Slider/Wheel resolution to be changed.

The default setting is 7 bits. Possible settings include: 0 to 7 bits.

Table 3. Menu explication (continued)

Number 
of menu

Name of 
menu

Explication of menu
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4 Advanced evaluation using a debugging environment 

4.1 Running the evaluation firmware in debug mode 

Designers can easily run the evaluation firmware in debug mode using either ST or third-
party toolsets (Raisonance, Cosmic, or IAR).

There is no need to use another hardware tool thanks to the ST-Link interface embedded on 
the board and accessibled through the USB connector.

Software tools to be downloaded separately include: 

● ST MCU toolset with ST Visual Develop (STVD) IDE and ST Visual Programmer 
(STVP) programming interface 

Note: the STVD toolset supports both Raisonance and Cosmic compilers.

● A C compiler of your choice:

– STM8 Cosmic C compiler (www.cosmic-software.com) 

– Raisonance C compiler (www.raisonance.com)

– IAR C compiler (www.iar.com)

In debug mode, designers can perform an in-depth evaluation of the firmware and visualize 
touch-sensing parameters. Designers can even customize the touch-sensing library to their 
specific needs by creating their own application firmware. 

For further information about STMicroelectronics software, STM8 microcontrollers, or 
debugging tools, please read the associated documentation or ask your local ST support 
team for a training session. More information is available at: www.st.com/touch-sensing-
library. 

4.2 Debugging the application using STVD
This section describes the steps necessary to set up a platform for evaluating and 
developing touch-sensing firmware using ST Visual Develop (STVD).

Note: For links to tools and downloads, please refer to ST's microcontroller web site at 
www.st.com/mcu/. 

1. Download and install the ST MCU toolset with ST Visual Develop (STVD) IDE and ST 
Visual Programmer (STVP) programming interface (single download). 

2. Download and install the STM8 Cosmic C compiler or the Raisonance C compiler.

3. Connect the USB cable between your PC and the STM8L evaluation board. The 
evaluation board is powered.

4. Download the STM8L evaluation board firmware and the latest STM8 touch-sensing 
library from www.st.com/touch-sensing-library;

5. Launch the STVD integrated development environment.

6. Load the STM8L evaluation board firmware (Figure 7) as follows: 
In the File menu, click Open workspace and Select/Open the file:
<Installation path>\STMT_8L-EV1 Evaluation Board Firmware Package\Projects\STVD
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Figure 7. Loading the STM8L evaluation board touch sensing library

7. In the Project menu, select Tools>Options>Toolset to define the C Cosmic location 
directory as shown in Figure 8.

Figure 8. Project settings 
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8. Build the project (Figure 9) by compiling and linking the source code as follows: 

a) Select Cosmic active project and Rebuild all in the Build menu.

b) When this process is completed, check there are no errors and no warning 
messages in the Output window.

Figure 9. Building the project
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9. Select SWIM ST-Link as the debugging tool as follows: 

a) In the Debug instrument menu, click Target setting.

b) Select Swim ST-Link as shown in Figure 10.

Figure 10. Debug instrument settings
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10. Start the debugging process as follows:

a) In the Debug menu, select Start debugging and wait for the connection with the 
evaluation board. 

b) In the Debug menu, click Run (or press CTRL-F5) to start the application in debug 
mode (see Figure 11).

Figure 11. Debug mode
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4.3 Exploring key structures 
All key and slider data structures can be monitored through the STVD watch window 
Figure 12). The main touch-sensing structures are sSCKeyInfo and sMCKeyInfo. 

To learn more about library variables and function descriptions, refer to the CHM file 
available at <installation path>\STM8 Touch-Sensing Library Package\stm8_tsl_um.chm. 

Figure 12. STVD watch window
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5 Performance

Touch-sensing performances may vary a lot from one application to an other. Thus, the 
information provided below is for reference only. It has been determined with the STMT/8L-
EV1 evaluation board programmed with the firmware v1.2.0C and with the default settings 
(all channels enabled, DI = 2).

5.1 Device power consumption
The STM8L15x device power consumption depends on several parameters:

● the number of touch-sensing channels supported

● the duration of the device run mode which is mainly defined by the acquisition duration

● the duration of the device low power mode (typically active halt mode)

The corresponding formula is given in Equation 1.

Equation 1

where: 

IDD = current consumption

Ta = acquisition duration

IDDrun = device power consumption in Run mode

IDDahalt = device power consumption in Active Halt mode

Tapp = application duration (the part of the application not related to touch sensing)

Tlp = low power duration

Table 4 provides a summary of the measurements.

         

Table 4. Summary of measurements

LP setting Tlp measured Ta + Tapp measured IDD

no LP —

9.3 ms

4.4 mA

1 ms 860 µs 4.0 mA

2 ms 1.7 ms 3.7 mA

4 ms 3.2 ms 3.3 mA

8 ms 6.3 ms 2.6 mA

16 ms 12.3 ms 1.9 mA

32 ms 25 ms
10 ms

1.3 mA

64 ms 50 ms 0.73 mA

128 ms 99 ms 11 ms 0.44 mA

256 ms 200 ms 12 ms 0.25 mA

IDD Ta Tapp+  IDDrun Tlp IDDahalt+  Ta Tapp Tlp+ + =
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Note: The low power duration (Tlp) may vary from board to board as the LSI oscillator is, by 
default, not calibrated.

5.2 Acquisition duration and reaction time
The acquisition duration depends on the sampling capacitor value, charge transfer 
frequency, layout ground parasitic capacitance, and electrode capacitance. When using 
STM8L15x devices, the acquisition of the 16 capacitive sensing channels is performed in 
two steps with up to 8 channels acquired in parallel. The duration of each step corresponds 
to the longer channel acquisition.

On the STMT/8L-EV1, the acquisition time of a:

● key is about 2.5 ms

● wheel or slider is about 4.5 ms

The formula used to determine the response time is given in Equation 2.

Equation 2

where: 

Tr = reaction time (the time from user touch to touch reported by the system)

Ta = acquisition duration

Tapp = application duration (the part of the application not related to touch sensing)

Tlp = low power duration

DI = detection integrator

Table 5 summarizes the reaction time depending on the low power mode setting.

         

Table 5. Reaction timer

LP setting Tr

no LP 28 ms

1 ms 30.5 ms

2 ms 33 ms

4 ms 37.5 ms

8 ms 46.8 ms

16 ms 64.8 ms

32 ms 105 ms

64 ms 180 ms

128 ms 330 ms

256 ms 636 ms

Tr DI 1+  Ta Tapp Tlp+ + =
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Appendix A Schematics

Figure 13. STM8L evaluation board
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Figure 14. ST-Link
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Section 1.2.1: Touch-sensing library: added “DxS” to “Detection 
exclusion system”.

Section 1.2.2: STM8L evaluation board: updated last bullet point 
concerning ST-Link.

Figure 2: Main features: added “U2”.
Added Figure 3: Joystick.

Section 1.3: User interface: updated bullet point concerning the 
joystick.

Removed Figure 3: Navigation scheme of the touchsensing library 
user interface.

Replaced Section 2.2: Dielectric
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Display submenus.
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information menus, Section 3.3: Slider and wheel menus, and 
Section 3: Getting started: aligned all menus with the STMT/8L-EV1 
evaluation firmware v1.2.0.
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